Improve the patient experience with Dentrix.
Provide your patients with an enhanced experience by using Dentrix eServices—powerful tools that help improve each step of your office workflow. Whether you want to market to new patients, keep your schedule full, manage the insurance process, or solicit patient reviews, there’s a Dentrix eService that can help. And when you bundle eServices together, you not only save money, you enhance your team’s productivity and improve the patient experience.

Visit Dentrix.com/Bundles to find a bundle that’s right for you.
If you’re a Dentrix Essentials customer, it’s time to step up your game. Right now you can claim deep discounts when you upgrade your service bundle to Momentum or Optimum.

Both bundles include eClaims so you can submit and track insurance claims electronically, directly from Dentrix. Upgrade now to add:

• eClaims for as little as 40 cents each
• Unlimited digital claim attachments
• Integrated billing and collection tools
• Automated appointment reminders
• Up to 20% transaction discount on eClaims, reminder postcards and QuickBill statements

Call 1-800-734-5561, option 2 to determine the best bundle for your practice.
CONTENTS

03 DENTRIX MASTERY TRACKS SPOTLIGHT

04 DENTRIX NEWS

06 PRODUCT MANAGEMENT
Dentrix Smart Image is Here
Learn how this new feature automates clinical workflow, improves treatment plan acceptance, and helps you build patient relationships.

09 TIPS & TRICKS

14 COVER STORY
Reinvent Your Dental Imaging Processes with Dentrix Smart Image
See images from multiple vendors directly in the Patient Chart.

20 FEATURE STORY
Become a Dentrix Clinical Specialist
Master the clinical skills in Dentrix and earn the recognition you deserve.

26 THE DENTRIX OFFICE MANAGER
Charting Referred Procedures
Discover just how easy it is to refer procedures in the Dentrix Patient Chart.

28 PRACTICE MARKETING
3 Essentials Features Your Practice Website Needs to Be Ready for 2019
To thrive in today’s online environment, make sure your website meets these fundamental business requirements.

30 REVENUE MANAGEMENT
New Codes in the CDT 2019 Update
Find out about the new changes and their potential impact on your insurance billing practices and dental practice revenue.

32 TECHNOTES
The Risks of Not Staying on Top of Your IT (And the Hidden Threats of Malware)
Focusing on your IT can take valuable time away from caring for patients, but if you don’t stay on top of your IT you risk the bad guys exploiting your patient data.

Dentrix Magazine Volume 30 Issue 4 — Winter 2018
Magazine.Dentrix.com
DENTRIX MAGAZINE NOW AVAILABLE IN THE PALM OF YOUR HAND!

Get Dentrix Magazine Online

Now, instead of waiting for the one printed copy to make the rounds in your office, everyone can read Dentrix Magazine whenever they want on their smartphone, tablet, or laptop!

SUBSCRIBE TODAY for Dentrix Magazine online at: magazine.dentrix.com
Where do you work?
I work at Ellis Family Dentistry (EFD), a large general practice in Chapel Hill, North Carolina.

What is your title?
Dental Assistant II is my title, but I have several different roles at EFD. I am the go-to person for maintaining clinical equipment, performing onsite IT maintenance, assisting all staff with Dentrix software issues or questions, and performing administrative tasks like scheduling, insurance collections, and running reports for practice analysis. I love helping Ellis Family Dentistry run efficiently, and I love learning new things.

How long have you been in the dental field?
I have been in the dental field for 14 years, and that’s also how long I’ve worked with Dentrix.

Which certificates have you earned?
I have earned the Front Desk Specialist, Financial Specialist, and Clinical Specialist certificates.

How has participating in Mastery Tracks helped you use Dentrix?
The Mastery Tracks program helped me learn about several features in the Dentrix software that my practice has not been using. The software is full of resources to help a dental practice run efficiently. It is exciting to learn more about how to effectively use Dentrix in its full capacity.

How has becoming a Dentrix specialist improved your career?
My job is secure because the staff depend on me. I love what I do. My employer is encouraging me to grow in my field and is giving me opportunities to advance in my career, and my Dentrix knowledge is helping her manage the practice. Having a growth mindset is helping me personally and the practice professionally. I hope to someday go beyond these walls and help train others.

What is your favorite Dentrix tip or trick?
I learn new tips weekly with the Dentrix Tip Tuesday emails (dentrixtiptuesdays.blogspot.com). Recently, I learned how to enter a specific hygienist as the provider for a patient’s continuing care. We were putting the information in the Prov2 field in the Family File, but when scheduling prophies for the patient Dentrix would always put the dentist (Prov1) as the appointment provider. It now defaults to the correct hygienist when scheduling recall appointments. That saves a click or two for each patient once it is set up, and is my favorite tip this week. I shared this with the entire team at our staff meeting on Tuesday. These small tips and tricks will make each day better in the long run. Next week, I will probably have another favorite tip, and I am looking forward to it.
Website Manager Templates Updated for ADA

The Americans with Disabilities Act (ADA) mandates by federal law that your website be compliant for use by 20 percent of the population with disabilities. This includes giving vision-, hearing-, and physically-impaired individuals the ability to navigate and interact with your website.

More than one billion people live with disabilities, including 57 million in the United States (https://www.census.gov/newsroom/releases/archives/miscellaneous/cb12-134.html). Many of them are unable to use computers, mobile phones, tablets, and similar technologies. Devices that should help to improve their quality of life instead become a source of frustration. By making your website ADA compliant, you will gain a new and loyal revenue source and minimize the risk of legal action against your company.

How Do People with Disabilities Use Your Website?

For the hearing-impaired:
• All audio content, including video, must have a written description.

For the visually impaired:
• All visual content, including pictures and buttons, must be properly coded for use by screen-reader software.

For the physically impaired:
• All website navigation, including hundreds of keyboard shortcuts, must be properly coded for those who cannot use a mouse.

Remediating Your Website

To ensure your website is ADA compliant and usable for all visitors, you need a qualified expert who specializes in auditing and remediating sites to meet version 2.1 of the web content accessibility guidelines (WCAG), the international standard set forth by the World Wide Web Consortium (W3C). Web developers are not—and are not expected to be—experts in ADA compliance. And free online tools fail to spot, on average, 70-80 percent of the compliance failures that lead to lawsuits (estimate by ADA Site Compliance).

Only a dedicated website compliance expert that combines both sophisticated technological and human expert auditing can identify the entire set of known issues that cause ADA non-compliance. He or she should provide you with detailed line-by-line reporting on specific errors in your website’s code, along with screen shots of each case and suggested steps for remediation. Your auditor’s report should be clear and precise, giving those tasked with remediating your site a step-by-step blueprint to achieve compliance.

Web Site Manager and ADA Compliance

Thanks to our recent work with ADA Site Compliance, the templates in Dentrix Web Site Manager have been updated and are now ADA compliant. You will need to use one of the new templates in Web Site Manager to be compliant. Then, any edits you make to the template you select, such as color changes (for correct contrast), and images (with alt tags), should be tested for compliance.

Be aware that it is ultimately your responsibility to ensure that your website is in compliance with ADA regulations, even if you use our templates. However, being compliant does not have to be expensive, difficult, or confusing. Legal and regulatory advisors like ADA Site Compliance can test your final website to ensure compliance.

For more information about ADA Site Compliance, visit www.adasitecompliance.com.

Important Payor Notifications

Medicaid of Arkansas (Payor ID: CKAR1) Trading Partner Update

Effective October 20, 2017, Medicaid of Arkansas will require providers to associate themselves to HSPPS’s Vendor Partner “Change HealthCare” Trading Partner ID of TP010036 for EDI claim delivery. You may complete this step by calling Medicaid of Arkansas Systems at 800-457-4454, Opt. 0, Opt. 1 for the EDI Helpdesk.

Principal Financial Group (Payor ID: 61271) Member IDs

To ensure the protection of member’s personal information, do not submit claims using their Social Security numbers. Use the member ID located on the member’s dental insurance card which typically begins with a “9” and is nine digits long located on the dental insurance card. Claims submitted with a Social Security number or incorrect member ID will be rejected by the payor.
Announcing New Insurance Payor Connections

Electronic Claims: Dentrix now has an eClaim connection with the following payor. If any of your patients are using this carrier, you can reduce paper claims and submit claims through Dentrix instead.

<table>
<thead>
<tr>
<th>Payor ID</th>
<th>Payor Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>70408</td>
<td>Sun Life Financial (PO Box 2940, Clinton, IA 52733)</td>
</tr>
</tbody>
</table>

Electronic Explanation of Benefits: You can now receive electronic explanations of benefits (eEOB/ERA) from the following payor.

<table>
<thead>
<tr>
<th>Payor ID</th>
<th>Payor Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPPCC</td>
<td>Cook Children’s Dental</td>
</tr>
</tbody>
</table>

View the entire list of electronic payor connections using the Payor Search Tool at www.dentrix.com/products/eservices/eclaims/payor-search.aspx. You can search for specific payors or download the complete payor list.

Call 800-734-5561 to enroll for eClaims or eEOBs or for help setting up any of these services.

2019 ADA-CDT Dental Codes Update

The 2019 ADA-CDT Dental Codes Update will soon be available for Dentrix customers running Dentrix G5.2, G6, G6.1, G6.2, G6.3, G6.4, G6.5, G6.6, G7, and G7.1. The update includes 15 new ADA-CDT procedure codes and changes to some existing procedure codes.

Dental offices on a Customer Service Plan using one of these supported Dentrix versions will have the update available through the Update Manager. In the Dentrix Office Manager (or any other main Dentrix module), from the Help menu, click About Dentrix, and then click Check for Updates. The CDT 2019 Update will appear under Updates. Select the CDT 2019 Update and click Install to install the update.

If you are not currently on a Customer Service Plan, please contact our Sales department today to learn more about the great benefits of being on a Dentrix Service Bundle. They can be reached by calling (800) 336-8749, option 1. You can also visit us at www.dentrix.com/servicebundles to learn more.
Dentrix Smart Image is Here

Automated Clinical Workflows
Smart Image is the first step of several initiatives to automate more of the work you do in your dental office. With Smart Image, we have created the ability to launch the image software and arm the proper imaging device without the need to leave the Dentrix Patient Chart. When you launch the imaging software and acquire the image, the selected procedure codes are then automatically posted to the patient’s ledger.

Compelling Treatment Plans
One way to improve profitability in your practice is to find ways to increase acceptance of treatment plans. Using Dentrix Smart Image is one small change that offices can make to improve treatment case acceptance. In Smart Image you can view multiple image modalities from multiple vendors on a monitor and use these images to tell a compelling story to the patient. In that conversation you can use those images as visual aids to explain important details, and make sure that your patients know the why, what, and how of the proposed treatment plan.

Building Relationships
I have been going to the same dentist for 30 years. The staff at my dental office know me and greet me by name when I walk in. They remember that I chipped my front teeth in a bike crash when I was eleven years old because they are the ones who restored my teeth.

Most patients value personal relationships with their dentist and dental staff and will appreciate efforts made to strengthen that relationship. Smart Image is a tool that will help you build relationships with your patients by keeping track of your patients’ dental imaging history right in your practice management software. Smart Image makes it easy for you to access more patient information quickly through a seamless integration without searching through separate software for a history of patient images.

So, what imaging software do you use? Sopro by Acteon? Romexis by Planmeca? Sidexis 4 by Dentsply Sirona? Chances are that you may even use a combination of these tools as you capture 2D and 3D images. The good news is that the opportunity now exists for any of these vendors to integrate. We already have working integrations with several vendors, and we will be building more of these connections over the coming months. Please check out our Smart Image webpage, www.dentrix.com/smartimage, to see the status of the connectors that are being built, and to learn more about Smart Image.

BEN NIELSEN
Dentrix Product Manager
SOME THINGS ARE WORTH REPEATING

PAYMENT DOUBLE ENTRY ISN’T ONE OF THEM

ELIMINATE THE HASSLE OF PAYMENT DOUBLE ENTRY.
Seamlessly integrated within Dentrix, the new Dentrix Pay enables you to master the art of processing payments. Our new tool will help you improve cash flow, increase reliability and eliminate the busywork of payment double entry. Contact us for a complimentary product demo.

Dentrix.com/Pay | 844.853.2285
Because,

“Hey, you should try my dentist!”

only gets you so far.

Marketing & Patient Communications Solutions for Dentrix users

- Automate appointment reminders and confirmations
- Manage your online reputation
- Send custom email and recall campaigns
- Offer online scheduling and two-way text
- Become mobile-friendly and responsive
- Track incoming calls

Contact us today to take control of your online reputation with this new comprehensive suite. Call 833-471-7253 or visit: demandforce.com/dental
The tips in this section describe valuable but easily overlooked Dentrix features that simplify workflow and increase efficiency. Find the tips that correspond to your role in the practice and try them out today. Start making your job easier and your practice more profitable.

Tips & Tricks

New Dentrix G7 Password Requirements
The requirements for Dentrix passwords have been updated in Dentrix G7, so if you are currently using passwords in Dentrix, when you upgrade to Dentrix G7 you will have to make a change. You’ll be prompted to change your password to one that meets the following complexity requirements:

- Is at least eight characters in length
- Contains capital and lowercase letters
- Has at least one number
- Has at least one special character

In addition to these new complexity requirements, Dentrix G7 also includes new password options. You can set password expiration dates, set rules for when an account is locked out after failed password attempts, and limit the use of previous passwords.

Note: Make sure only the doctor, office manager, or practice administrator has rights to change these new password options.

How To
1. From the Office Manager, click Maintenance > Practice Setup > Passwords > Practice Passwords Setup.
2. Click Password Security.
3. Set the following options as needed for the practice:
   a. Password Expiration – use the options here to give passwords an expiration date and a warning that passwords are about to expire
   b. Password Security – set a number of passwords attempts before a user gets locked out, and the amount of time they will be locked out for
   c. Password History – set a limit for the use of previous passwords.
4. Click OK to apply these settings.

By setting these options, you can make sure that user passwords in your practice are being updated regularly.

Practice Analysis

Follow us on Facebook and receive Dentrix tips in your News Feed. www.Facebook.com/Dentrix
Comparing Perio Exam Information

When you see patients for periodontal maintenance, it can be helpful to show them a comparison of today’s exam versus their previous one, particularly if there are important changes or improvements you want them to be aware of.

In the Dentrix Perio Chart, you can easily compare the results of up to five periodontal exams at once.

How To:
1. In the Perio module, click View > Exam Comparison. Check the exams you want to compare and click OK.
2. Click the Show Options button to select the information you want to compare on the exam.
3. In the Compare/View group box, select the data or graphical information you want to compare.
4. Click Close to return to the Perio module.

Clinical

Printing Care Instructions for Specific Procedures

With some procedures, there are a few reminders or care instructions you want to give patients. Rather than having to write these reminders on an appointment card or create a separate document for those instructions, you can attach them to the procedure so they are automatically printed with the patients’ walkout.

For example, you may typically tell patients who have had fluoride varnish applied to avoid sticky foods, hot drinks like coffee, and carbonated drinks for at least four hours. Printing those instructions on the walkout will serve as an additional reminder if the patient forgets what you said or has questions about the instructions after they leave the office.

How To:
1. In the Office Manager, click Maintenance > Practice Setup > Procedure Code Setup.
2. Select the procedure code you want to add care instructions for, and click Edit.
3. In the Procedure Code Editor dialog box, click Edit Note.
4. In the Recommendation Note section, enter the text to appear on the note and check the Print Note on Walkout box.
5. Click OK to save the note and then click Save.

Whenever you post this procedure complete, the note you added will be printed with the walkout statement that includes that procedure.
Separating Allergies and Medical Conditions

If you’ve upgraded to Dentrix G7, you’ve probably seen the new Health History module. One of the great new features that wasn’t available in previous versions of Dentrix is the ability to separate medical alerts and allergies. In previous versions, they were all in the same list, and some offices would label the allergies with a hyphen to keep them alphabetically together in the list (for example: Allergy-Penicillin).

With the Health History module, you don’t have to do that! There are separate categories for medical conditions and allergies. And best of all, there are no limitations on how many medical conditions or allergies you can store in your database!

When you upgrade to Dentrix G7 all your previous medical alert entries are imported when you upgrade, but they are still in one list. You can quickly move the allergies you had saved into their own category with just a few quick mouse clicks.

How To
1. From the Health History module, click the Setup button (looks like a gear in the top right corner).
2. Click the Medical Conditions tab and highlight any allergies on the list. Hold down the CTRL key on your keyboard to select multiple conditions at once.
3. Click the Move to Allergies button.

Front Office

New Patient Appointments: Additional Ways to Contact the Patient

Did you know that when you create a new patient appointment you have the ability to add a mobile number and email address for the patient? These new patient information fields, added in Dentrix G6, accommodate those new patients who don’t have a home phone number or who prefer to communicate with your practice via email. By creating a new patient appointment and entering this information, you have a way to contact the patient before their appointment should you need to.
Setting Up Time Blocks for Providers

If you have a provider in your office who prefers crown appointments in the morning and to see new patients from 3-5pm on Tuesdays and Thursdays, you can set up time blocks that match their preferences.

How To
1. From the Appointment Book menu, select Setup > Provider Setup.
2. Select a provider and click Setup.
3. In the Set Time Blocks group box, click Add.
4. Give the time block a name, such as NP Appt or Crowns, and select a color that will be used to designate it on the schedule.
5. Select the day(s) and times for the time block, and select an operatory and appointment type for the block, and click OK.

Once time blocks are assigned, turn on the Perfect Day Scheduling function to see those block in the Appointment Book. The Perfect Day Scheduling button is the last button on the Appointment Book toolbar, and toggles on or off with each click.

When you schedule appointments within a time block, Dentrix checks to see if the appointment matches the type of appointment the block is intended for. A notification appears if the provider or appointment type doesn’t match the settings of the time block. You can override the message and schedule the appointment anyway, if needed, but the notification serves as a reminder to keep that time available for certain types of appointments.

Saving Credit Cards on File with Dentrix Pay

It’s the start of a new work week. One of your to-do list tasks is to find accounts that are due for a recurring payment, manually charge their credit card on file, and enter the payment in Dentrix.

What does “on file” mean in your practice? Do you open a hidden spreadsheet on your computer that contains the card information? Do you unlock one of the drawers up front and pull out a list of card numbers?

With Dentrix G7 and Dentrix Pay, a new feature which can be bundled together with other eServices you are already using, you have the ability to save credit card information within Dentrix that can be used for authorized recurring payments, like payment agreements, all from inside the Ledger.

How To
1. With a patient selected in the Ledger, click Transaction > Saved Credit Cards.
2. Click Add and insert or swipe the credit card using a connected PINpad device.
3. Notify the patient of a $2.00 pre-authorization charge, which will be reversed after the account is verified.
4. Have the patient review and sign the consent form to authorize your office to charge their card on file.
5. Save the consent form and print a patient copy if needed.

Once you have saved a credit card, it will appear as an option when you click the Process Card button in the Enter Payment window of the Ledger.

For more information, click the Quick Start Videos for Dentrix Pay link on the Resource Center login page to watch tutorials and view key information.
Upgrading to Dentrix G7?
Let us help you upgrade your software skills as well!!

Buy 8 hours of Dentrix Upgrade Training for only $900*!

For a limited time, buy 8 hours of Dentrix software skills training focused specifically on the NEW features available in Dentrix G7 for only $900*!

But you will need to act fast.
This offer expires Dec 31, 2018 and training must be completed within 6-months of purchase date.*

Sign-up today at:
www.Dentrix.com/UpgradeTraining

* That is a $100 savings off regular Dentrix training rates for 8 hours. Offer available only for a limited time.
What practice isn’t looking for ways to improve reimbursements, increase staff and workflow efficiency, and improve the customer experience? Few might have thought it possible to do all three at the same time; however, that is just what the new Dentrix Smart Image feature provides.

Released as part of Dentrix G7 by Henry Schein One, Smart Image is the new way to interface with your imaging software. This new technology goes well beyond traditional imaging bridges by providing two-way connectors that give you access to your images from multiple imaging vendors, all right within the Dentrix Patient Chart. In addition, the technology lets you automate imaging workflows in unprecedented ways—resulting in benefits for multiple aspects of your practice.

**Improve Imaging Reimbursements**

During an appointment, team members sometimes take additional images that were not originally scheduled. If so, procedure codes that should be billed may not be communicated and slip through the cracks. Enter Smart Image. When a team member starts the image acquisition process by selecting the procedure in Smart Image, Dentrix ensures the code is posted to the Ledger. This helps you confirm that all eligible images are appropriately coded for submission and payment.

See images from multiple vendors within the Patient Chart.
To acquire an image, click the Acquire a 2D/3D or Cad/Cam Image button. Then select the procedure code, verify the details to be credited for the procedure (including the provider), and click Acquire Now (Figure 1).

As images are taken, Smart Image automatically posts completed imaging procedures to the Ledger. Beyond saving time and steps for team members, automated posting supports prompt, accurate billing.

**Increase Efficiency**

In the past, preparing to take images could be a time-consuming process: (1) starting the imaging software, (2) selecting the patient, (3) choosing the sensor and (4) selecting the template. No longer with Smart Image. After the procedure and CDT codes are selected, Smart Image can automatically open the imaging software and arm the correct sensor, saving you steps and time.

And if you have images saved across multiple imaging programs, locating the correct image can feel like searching for a needle in a haystack. Instead, Dentrix Smart Image displays image thumbnails on the Patient Chart for all patient 2D and 3D images from any participating Smart Image partner. Just click the Show Thumbnails of All Images toolbar button, and the Smart Image panel appears (Figure 2).

This panel updates each time you acquire a new image. Dentists and team members are spared the time and hassle of looking through multiple systems to find available images—plus this helps to avoid accidentally overlooking images.

---

**Figure 1** Select the details about the procedure before you take the image.

**Figure 2** View images from multiple imaging partners in one place.
Improve the Patient Experience

The time you spend searching for images means that your patients spend unnecessary, anxious moments waiting in the operatory. To help you quickly locate the image you need, Smart Image lets you filter your patient’s images many different ways—including by date, imaging vendor, image type, and tooth number (Figure 3). When you locate the images you need quicker, procedures can be completed quicker, making the experience better for you and the patient.

In the past, precious time could be lost when you had to locate and compare images, especially if the images resided across multiple systems. Dentrix Smart Image makes side-by-side comparisons across imaging systems easy-peasy! Smart Image not only provides you access to all of your images in one place, but it also lets you “pin” up to four images on the screen at once for easy comparisons.

Pinning images is easy. Single-click a thumbnail from the Smart Image tray, and an image preview appears. Click the pushpin button at the top of the image preview to pin it, and then click another thumbnail (Figure 4).

Beyond the diagnostic value and increased speed, this comparison capability could also be very helpful when presenting a clear, concise treatment plan. When patients are better educated about their dental needs, the prospects for treatment acceptance increases. Patients who receive the best treatments have the best outcomes—the end result being a superior patient experience.
Another option for viewing multiple images in Smart Image is the “most recent” panel. Here you’ll see each of the most recent images for six different image types. Click the arrows within in each image type to scroll chronologically through those images (Figure 5). The Most Recent panel is one more way of providing multiple images in side-by-side comparisons, which promotes faster, more accurate diagnoses and treatment. Your patients will benefit from the accuracy—and spending less time in the operatory.

“Smart Image has made taking and retrieving radiographs and other media so much easier. Previously, they were stored in different programs, and errors could easily be made linking these programs to the correct patient. Also, some of the bridges used to link these were unreliable and would crash. With Smart Image there are virtually no extra steps. In fact, it is so smart that when you post a code in Dentrix, it will automatically open up Sidexis 4 for you and be ready to take the image.”

DR. JEFFREY S. REIN
Long Island Smile Dentistry
Williston Park, NY

Figure 5 View the most recent images for six different image types.
Get Smart Image Now
Dentrix Smart Image is available for users of Dentrix G7 or higher. Connectors to participating imaging vendors are provided at no additional charge to users with a current Dentrix service bundle.

Smart Image provides you with a powerful, unified process that can help ensure you charge for procedures performed, increase your efficiency (both staff productivity and saved time by streamlining office workflows), and improve your patient experience.

LEARN MORE
To learn more about Dentrix Smart Image, and to see the list of participating imaging vendors, visit www.dentrix.com/smartimage. See a 23-minute video presentation on the new features of Dentrix G7, with extended information about Smart Image by going to http://bit.ly/2yk381H

DENTRIX G7 WITH SMART IMAGE AWARDED 2018 CELLERANT “BEST OF CLASS” TECHNOLOGY AWARD

At the 2018 ADA Conference in Honolulu, HI, Dentrix G7, featuring Smart Image, received the prestigious Cellerant “Best of Class” Award. Brad Royer, Dentrix Product Manager, was on hand to accept the award and answered questions about Smart Image afterward. To hear Brad’s comments, go to www.dentrix.com/awards. The Cellerant judges gave high praise to Smart Image:

“Finally, someone has figured out how to take all of your images (digital impressions and CBCT included) and make them visible in practice management software. We have all been waiting for the ability to view any image from inside the patient’s chart. Dentrix users rejoice! Others should upgrade ASAP.”

—John Flucke, DDS

“How is Dentrix no longer locked to using one imaging solution, having opened up the software to allow many imaging software packages direct integration into the patient chart. Less clicks are required to find images, and it is easier to use. This is the reason to upgrade if you have been holding off.”

—Marty Jablow, DDS

“As a practice owner, it is frustrating when radiographs are exposed on a patient and the procedure is overlooked during billing. Dentrix G7 Smart Image can connect an exposed image to the proper CDT code to allow a practice to accurately assess the number of images taken and ensure that the images are billed correctly. In addition, all modalities of images can all be stored within the patient record in Dentrix. This is extremely convenient—I like having all of my patients’ information in one place.”

—Pamela Maragliano-Muniz, DDS

To learn more about this and other Dentrix accolades, visit www.dentrix.com/awards

When your stand-alone imaging solutions don’t seamlessly integrate with Dentrix, you waste your patient’s time and minimize the care you provide. But with Dentrix Smart Image, you can access all your diagnostic images in the patient chart without bridges or multistep integration paths while also tagging those images with CDT codes that automatically post to the Ledger. Now you can focus on your patient, not just their images, and be confident you’ll get paid for the work you do.

Learn more at Dentrix.com/SmartImage
There is nothing more important in your dental practice than maintaining accurate, thorough patient records. According to the ADA, the dental record provides for continuity of care for the patient and is critical in the event of a malpractice insurance claim. The dental record is the office document that records all diagnostic information, clinical notes, treatment performed, instructions for home care, and consent for treatment.¹

An important part of creating a dental record in today’s dental industry is entering procedures, clinical notes, and treatment recommendations digitally. The Clinical track in Dentrix Mastery Tracks™ is designed to help you master those skills in Dentrix. The Clinical track will give you the Dentrix knowledge and skills to enter procedures, conditions, and referrals in the Patient Chart, record medical conditions and patient health history, and create and track patient prescriptions. You’ll also gain insight and learn practical steps to create clinical notes to document treatment, organize treatment plan options, and present treatment to patients and encourage case acceptance.

Best of all, when you complete all of the courses and tests in the Clinical track, you’ll receive a Dentrix Clinical Specialist certificate and earn the respect and recognition you deserve from your dentist, your practice team members, and your peers.
What is Dentrix Mastery Tracks?
Dentrix Mastery Tracks includes courses and tests that help you improve your Dentrix skills and master the tasks you do every day. There are four tracks: Front Office, Financial, Clinical, and Practice Analysis. The Clinical track is ideal for dentists, hygienists, dental assistants, treatment coordinators, and other team members who routinely chart treatment, write clinical notes, or document treatment plans.

The courses are online and on-demand, so you can study wherever and whenever it’s convenient for you and learn at your own pace. All you need to get started is a Dentrix Customer Service Plan and your Dentrix customer ID number.

Take a course. Take a test. Earn a certificate.
The process is simple. You take a course and then take the test that goes along with the course. When you pass the test, you earn a certificate (Figure 1).

There are two courses in the Clinical track: Charting Mastery and Treatment Planning Mastery. You can take both courses from start to finish, focus your study on new skills you want to learn, or study processes you want to improve to make your routine daily tasks easier.

Each course contains three to six lessons, and each lesson is made up of several topics. Each topic includes an introduction that describes a Dentrix task and when to use it, a short video that shows how to perform the task, additional tips that give extra insights about the task, and a practice exercise that helps reinforce learning.

When you complete a course, you can take a test to check your understanding. If you pass the test, you’ll earn a certificate to show your achievement.

Become a Dentrix Clinical Specialist.
When you pass both tests in the Clinical track, you’ll earn the Clinical Specialist certificate. Earning the Clinical Specialist certificate shows that you have mastered the Dentrix skills to support accurate and complete procedure entry, clinical note documentation, and treatment plan creation.

In addition, you’ll learn about some of the Dentrix clinical features and processes that you may not be aware of or use in your practice, including prescriptions, perio charting, and lab case management. You’ll improve your clinical documentation skills in Dentrix and make your clinical processes more efficient.

Get the Recognition You Deserve.
You have a wide range of experience and expertise, and you deserve to be recognized for everything you can do! As a Clinical Specialist, you’ll be able to demonstrate your value as a skilled member of the dental team and earn greater respect, trust, and responsibility. You’ll enjoy greater confidence in your own skills and find more opportunities to grow in your career.

Read the sidebar on page 24 to hear from several Clinical Specialists and find out how becoming a specialist increased their confidence and made them a more valuable member of their dental team.

Learn on your own schedule.
We know your office is busy. We designed Mastery Tracks online learning and testing with flexibility in mind so you can easily fit it into your day.

You don’t have to go through an entire course or lesson at once. Each lesson has 10-15 short topics, and each topic will only take three to five minutes to complete. Plus, the courses are set up in a system that allows you to mark what you have completed as you study. That means you can study a few topics at a time when you can fit a little learning with the other things you’re doing in the office.

Figure 1 When you pass a test, you’ll receive a certificate. If you earn both Clinical certificates, you’ll become a Clinical Specialist.
Then, when you return to the course, you’ll know exactly where you left off.

Each Clinical mastery test includes 33-40 questions and may take up to 60 minutes to complete.2 The good news is that you don’t have to take a whole test at once. You can pause a test and save what you have done, and then come back to the test at a more convenient time.

Get the whole office involved.
You know all too well that the clinical team is always busy. Wouldn’t it be nice if some of the front office team members could help chart treatment, verify clinical notes, or organize treatment plans? It’s common for front office team members to view and call in prescriptions and describe post-treatment care to patients, so it’s important that those team members know how to find that information in Dentrix. And just think how much more likely patients would be to accept treatment plans if everyone in the office could see the doctor’s recommended treatment plan and express confidence in the doctor’s skill and reassure the patient that they will feel happier and healthier.

Use the Clinical track to help other team members expand their skills and learn to use Dentrix in new ways. Schedule coordinators can look at treatment plans to determine how many visits to schedule for a patient’s treatment. Office managers can review clinical notes to ensure they are complete and accurate. Insurance coordinators can review treatment plans to estimate coverage for treatment options and determine which procedures may require pre-authorization.

When you help other team members learn how to enter procedures and review treatment plans, you’ll improve teamwork and increase the level of service you provide to your patients. When dental team members are cross-trained, they understand the challenges and tasks associated with each other’s jobs, and that fosters understanding and camaraderie.

What about team members who are new to Dentrix?
The Clinical track is ideal for team members with more than a year of experience using Dentrix who are ready to advance their Dentrix skills. If you’re new to Dentrix, there’s a Mastery Tracks option for you too. You can get up to speed and learn basic Dentrix skills by completing Dentrix Essentials courses and tests.

**HOW DO I ACCESS DENTRIX MASTERY TRACKS COURSES AND TESTS?**

It’s easy to get started!

2. In the Get Your Training section, click Enter.
3. Click Register to create your learner account, or log in if you already have one. You will be required to create a personal username and password so you can track your learning progress.
4. Under Study for Mastery, click Courses, click the course you want to take, and then click a lesson to begin learning.
The Essentials learning level is the foundation for Dentrix Mastery Tracks. It includes brief courses and short tests of fundamental skills that are perfect for team members with less than a year of Dentrix experience.

The Clinical Essentials course will help you build the foundation of charting and treatment planning skills. Then, once you’ve completed the Dentrix Essentials courses and tests and you’re ready to expand your skills, you can move on to the Mastery level courses and tests and become a Dentrix Clinical Specialist.

Get started today!
Today is the day to master the clinical tools in Dentrix and become a Dentrix Clinical Specialist. Visit www.Dentrix.com/Mastery/Clinical to learn more about Dentrix Mastery Tracks and get started.


2 Mastery tests cost $19.95 per test and include two attempts to pass each test.

LISTEN TO WHAT OTHERS HAVE TO SAY!

These dental professionals have earned the Dentrix Clinical Specialist certificate. Read on to find out how becoming a Clinical Specialist has helped them increase their Dentrix expertise and become more confident in their Dentrix skills.

Dentrix Mastery Tracks has given me a more comprehensive view of both the software and of our office as a whole. I am now able to be more efficient and thorough with detailed tasks such as charting and setting up comprehensive treatment plans.

- Erin Silva, Hygienist

Not only has it boosted my confidence attaining the Dentrix specialist title, it has helped me become a better trainer for our new team members.

- Monica Robinett, Senior Financial Coordinator

I feel like I can better assist my patients and work better with our front desk to make our office run as smoothly as possible.

- Lisa Dunlap, Registered Dental Hygienist

I think it’s important to know as much as possible about my practice and the way it runs. The Mastery Tracks evaluation actually helps me identify learning and training needs that I might not otherwise be able to recognize.

- Carla Sullivan, DMD

Becoming a Dentrix specialist has helped me to gain a wider range of opportunities to apply my skill set in the dental industry.

- Anais Dakin, Orthodontic Assistant

By becoming a Dentrix specialist I have helped to shorten the time for the clinical staff to create treatment plans and complete clinical notes, and now they can do it more thoroughly with fewer clinical errors.

- Chuc Nguyen, Registered Dental Assistant

Becoming a Dentrix specialist has helped me to become more assertive in the workplace, and I have been given more opportunities to showcase my skills.

- Ana Ebanks, Office Coordinator

To read about other specialists, check out the Dentrix Mastery Tracks specialist spotlights at www.Dentrix.com/Mastery/Spotlights.
Become a Dentrix KNOW-IT-ALL!

Dentrix Mastery Tracks™ online training will help you become the Dentrix KNOW-IT-ALL your office needs!

Mastery Tracks training will help your team members better prepare to use Dentrix on the job—in just a matter of days. Team members can learn the essential components of Dentrix, allowing them to be more effective right away. Even long-time employees can benefit from a great refresher. And, for team members ready to expand and deepen their skills, Dentrix Mastery level training is also available.

Mastery Tracks online training is included with your Dentrix Customer Service Plan. So, what are you waiting for? Become the team KNOW-IT-ALL today!

Take advantage of all that Dentrix Mastery Tracks has to offer. Log in at Dentrix.com/resource-center and select “Get Your Training.”
Discover just how easy it is to refer procedures in the Dentrix Patient Chart.

Have you ever needed to find the date when a referred procedure was completed? For example, you have a patient in the chair, and the doctor needs to know when the patient’s implant was placed, or their root canal was completed. Charting referred procedures in the Dentrix Patient Chart can help in several ways. You know the patient’s chart information is accurate, and it quickly provides the information you need without having to search through a paper chart or the patient’s Document Center files.

When you chart referred procedures, you can also help to generate production. Because the referred procedures are recorded in the Patient Chart, your doctor can easily see that an implant was placed three months ago and is ready to restore. You can go ahead and schedule the patient’s appointment for the implant restoration while the outstanding treatment is still fresh in their mind. Or if your schedule permits, you can provide treatment the same day.

How to Chart Referred Procedures

When a procedure is treatment planned in the Patient Chart, the letters “TP” appear in the Status column. Double-click the procedure to open the Edit or Delete Procedure dialog box. Under Related Referral, click the search icon next to Referred. Make sure Referred To Doctor is selected, and click OK. In the Select Referred To dialog box, select the referral doctor, and then click OK. The referral doctor now appears under Related Referral (Figure 1). Click OK again.

In the Patient Chart under the “R” column (for Referral), an “R>” symbol is added next to the procedure to show that it has been referred. The Amount column also changes to 0.00 for this referred procedure. The referred procedure still prints on the patient’s printed Treatment Plan Case. I like this because it communicates to the patient that that procedure needs to be completed. Also, if you have set visits in their treatment plan, the patient knows in what order the treatment should be completed.
Once the treatment has been completed by the referral doctor, you can mark the procedure as completed in the Patient Chart. Because it was done by another provider, the procedure will have an Existing Other status in the Patient Chart and will appear as Existing Other in the graphic chart (Figure 2).

I like the visual reminder of seeing the unrestored endo tooth in the Patient Chart because it reminds me that the crown still needs to be scheduled.

**Printing a Referral Slip**

Did you know you can print a referral slip right from the Patient Chart to give to your patient? This can save time having to handwrite a referral and then scan that referral into the Dentrix Document Center. After you have marked a procedure as Referred To Doctor in the Patient Chart, from the File menu, point to Print, and then click Referral Slip. The date range will default to today’s date, but you can change the date range as needed to include the date of the referred procedure (Figure 3). You also have the option to write an additional note on the bottom of the referral if there is something you need to communicate to the referred to doctor.

Charting referred procedures in the Patient Chart can save you time. You no longer have to search for referral information—it will all be in one place. Furthermore, the Patient Chart will be more accurate with a record of all procedures, including those that were referred out to another doctor. DM

**LEARN MORE**

To learn more about referring procedures in Dentrix, see the “Editing Treatment” topic in the Dentrix Help.

Charlotte Skaggs is the founder of Vector Dental Consulting LLC, a practice management firm focused on taking offices to the next level. Charlotte co-owned and managed a successful dental practice with her husband for 17 years. She has a unique approach to consulting based on the perspective of a practice owner. Charlotte has been using Dentrix for almost 20 years and is a certified Dentrix trainer. Contact Charlotte at vectordentalconsulting@gmail.com.
To thrive in today’s online environment, make sure your website meets these fundamental business requirements.

A good website has much in common with a good house. Both have a world of amenities and every buyer will have different priorities. One buyer might prefer gas stoves over electric, and another might value a spacious patio. But all can agree that their house will need walls, a roof, and central heating.

The same is true of websites. To thrive in today’s online environment, your website needs to be mobile responsive, HTTPS, and in line with accessibility guidelines. Without these three things, your practice website will be unfit for living.

**Mobile Responsive Web Design**

If a website takes a long time to load or is difficult to use on mobile devices, many patients will leave within three seconds. That’s not a lot of time to make a great first impression.

A mobile responsive website uses responsive web design. This approach to web design ensures that your website will load on a variety of devices (like smartphones or tablets). Your website will work well and look great no matter what device patients are using to access your website.

Mobile responsive websites might not have been high a priority a few years ago, but now 51.2 percent of global internet traffic comes from smartphones and tablets worldwide. If your site isn’t equipped to handle those devices, you’re missing out on over 50 percent of patients searching for your practice online.

By having a mobile responsive website, you’re also ready for any new connected devices (for example, smart TVs, watches, glasses, etc.) that may be developed in the future. This means you won’t have to worry about whether your website will need to be rebuilt for a long time to come.

**Make Your Website HTTPS**

Effective July 24, 2018, Google Chrome began to label all websites that don’t use HTTPS as “Not Secure” in the address bar of the website browser. But what does this mean for you?

Website visitors, and potential patients, may be dissuaded from providing any of their information or even accessing a website that Google Chrome has determined is “Not Secure.” Since over 60 percent of all website visitors use Chrome as their default browser, adopting HTTPS may be key to making your websites appeal to the largest user base on the web.

**Adherence to ADA Guidelines**

We’re not talking about the American Dental Association here. ADA, in this case, stands for the Americans with Disabilities Act—the same legislation that requires your physical practice to be accessible to those with disabilities.

While it’s not clear what makes a website “ADA accessible,” there are recommended guidelines for making websites accessible. To see the comprehensive list of guidelines, see the Web Content Accessibility Guidelines “Level AA Success Criteria.” We recommend adopting these guidelines as an industry best practice for your practice website.

**Next Steps to Learn More**

These are the bare-bones minimum of what to look for in a new website. Of course, there are plenty of customization options available, and you should choose the website that’s right for you. All Dentrix websites powered by Officite provide these three fundamental business requirements.


---

2. [https://security.googleblog.com/2016/02/a-secure-web-is-here-to-stay.html](https://security.googleblog.com/2016/02/a-secure-web-is-here-to-stay.html)
4. [https://www.w3.org/WAI/standards-guidelines/wcag/](https://www.w3.org/WAI/standards-guidelines/wcag/)
Seamlessly Integrate Dentrix G7 with Schick Sensors

Schick 33 sensors are the only sensors that enable bi-directional integration with Dentrix G7 software. Together, they can save you time on image retrieval, help you acquire and bill for the right images, and streamline chairside patient communication. Elevate your dental imaging, care, and practice by using these products together.

Rely on Henry Schein and Dentsply Sirona to empower you and your practice for the future.

To Learn More Visit: www.henryscheindigital.com/schick-g7
Find out about the new changes and their potential impact on your insurance billing practices and practice revenue.

The ADA’s Code Maintenance Committee (CMC) is responsible for maintaining the code on Dental Procedures and Terminology (CDT), the standardized language for the dental profession. These codes allow dental teams to clearly communicate with patients regarding proposed dental treatment, accurately document the services performed, appropriately bill for services, and communicate correctly with third-party payors about the dental treatment submitted for reimbursement.

The CMC meets annually to review, discuss, and vote on all submitted CDT code changes. At this meeting, the CMC chooses to accept, amend, or decline requests based on the combined best interests of the profession, patients, and payors. This article reviews a few of the most notable new codes added to CDT 2019.

**Blood Glucose Level Testing**

*DO412 blood glucose level test – in-office using a glucose meter*

This procedure is used to document a patient’s blood glucose level at the time of sample collection. Many dentists perform a blood glucose test for diabetic patients prior to performing complex dental procedures to avoid a possibly life-threatening event. Code DO412 provides the means to properly document this test even when there is not a charge for the test. A dental plan may exclude DO412 from coverage; however, medical plans do typically consider reimbursement for blood glucose testing.

A dental practice may be subject to Clinical Laboratory Improvement Amendments of 1988 (CLIA) regulations if the practice performs a blood glucose test even if there is no charge to the patient or claim submitted for the service. Additionally, a state dental board may consider a blood glucose test outside of the scope of dental practice. Therefore, it is important to check with your state dental board and CLIA rules and regulations prior to implementing blood glucose testing in your practice.

**Arch Treatment for Partial Dentures**

*D1516 space maintainer – fixed – bilateral, maxillary*

*D1517 space maintainer – fixed – bilateral, mandibular*

*D1526 space maintainer – removable – bilateral, maxillary*

*D1527 space maintainer – removable – bilateral, mandibular*

*DO5282 removable unilateral partial denture – one-piece cast metal (including clasps and teeth), maxillary*

*DO5283 removable unilateral partial denture – one piece cast metal (including clasps and teeth), mandibular*

The codes listed above have been added to CDT 2019 to distinguish the arch treated for partial dentures. This was necessary because the CDT 2018 space maintainer codes and removable unilateral partial dental codes did not indicate the specific arch treated. Note that with the addition of these new codes, the CMC also removed three related codes from CDT 2019:

*DI515 space maintainer – fixed – bilateral*
These three new codes were added to cover different types of occlusal guard:

- **D9940** occlusal guard, by report
- **D9944** occlusal guard – hard appliance, full arch
- **D9945** occlusal guard – soft appliance, full arch

The descriptors of these new occlusal guard codes clearly indicate that these appliances are provided to minimize the effects of bruxism or other occlusal factors. These codes are not to be reported for any type of sleep apnea, snoring, or TMD appliances.

The CDT 2018 code **D9940** occlusal guard, by report did not specify full or partial arch nor indicate the type of guard, hard or soft. The addition of **D9944**, **D9945**, and **D9946** eliminates the need for “by report” and allows for more accurate reporting of the actual procedure performed resulting in more accurate reimbursement consideration.

**Conclusion**

Remember that just because a CDT code exists (new or established), this does not mean it will automatically be reimbursed by payors. While payors are required to recognize current CDT codes when submitted on claims, they are not required to pay them. When establishing dental benefits for their employees, employers are offered extensive options, so each plan can be very different. Plans vary, and dental services covered by one patient’s dental plan are not necessarily covered by another.

It is very important that doctors and dental teams remain current with all annual CDT code changes. New, revised, and deleted codes for CDT 2019 will go into effect on January 1, 2019. The CMC will continue to meet annually to consider necessary CDT code set additions, revisions, and deletions to make sure the existing code set is usable.

Code changes to CDT 2019 include 15 new codes, 5 revised codes, and 4 deleted codes. This article reviews a few of the new codes added to CDT 2019. Please visit [www.practicebooster.com](http://www.practicebooster.com) to learn more about my coding and administration resources.

Dr. Charles Blair is dentistry’s leading authority on practice profitability, fee analysis, insurance coding strategies, and overhead control. He has individually consulted with thousands of practices, helping them identify and implement new strategies for greater productivity and profitability. Dr. Blair's extensive background and experience make him uniquely qualified to share his wealth of knowledge with the dental profession. A widely-read and highly-respected author and publisher, Dr. Blair offers four publications, Coding with Confidence, Administration with Confidence, Medical Dental Cross Coding with Confidence, and the Insurance Solutions Newsletter. He also created the CDT Code Advisor at [www.practicebooster.com](http://www.practicebooster.com), which offers practical guidance for the real-world application of CDT codes. Dr. Blair holds degrees in accounting, business administration, mathematics, and dental surgery.
The Risks of Not Staying on Top of Your IT (And the Hidden Threats of Malware)

Focusing on your IT can take valuable time away from patient care, but if you don’t stay on top of your IT you risk the bad guys exploiting your patient data.

Almost all dental offices now use some kind of information technology (IT). This offers convenience but, unfortunately, also introduces new threats to patient data and your practice. Keeping your operating system (OS), anti-virus and other software up to date can help protect your practice from threats—but focusing on your IT can take your valuable time away from caring for patients.

However, if you don’t stay on top of your IT, you risk the bad guys exploiting your patient data.

Hackers’ Favorite: Ransomware
One of a hacker’s favorite tools is ransomware, a form of computer malware that restricts access to your computer or its information, while demanding you pay a ransom to get back access to your data. Ransomware has been around a long time, but when Cryptolocker and Cryptowall were released in 2013, they earned their attackers some big money1, helping make ransomware attacks a favorite new way for hackers to profit—at the expense of you and your patients.

Ransomware hackers often target small-to-midsize businesses (SMBs), including dental practices because SMBs often lack resources to defend against these types of attacks. According to a Kaspersky report, in 2016, 42 percent of SMBs were hit by ransomware in the past 12 months, making ransomware a very significant threat.2 So if you have an internet connection in your practice, you could be at risk.

Importance of a Layered Defense
Because hackers are always looking for new ways to steal your patient data, it is important to have a layered defense strategy. Your layered defense should always include:

- Current software and OS patches, updates and licenses
- Gateway antivirus and behavior-based malware detection software
- A business-grade firewall such as WatchGuard
- Data encryption using AES 256-bit encryption
- Frequent data backup in at least two separate locations, ideally one in the cloud

Attacker love re-using old exploits because so many organizations don’t stay up-to-date on security patches. In fact, last quarter, every one of the top 10 network attacks affecting WatchGuard customers was at least two years old.3 Your patient data may still be in danger from these old attacks, as well as the new vulnerabilities found almost every day that hackers just keep adding to their toolbox. Do you know if you are at risk?

The Value of Protecting Your Practice Data
How much would it cost you if your practice shut down for a day—or a week? What about the fines, fees, and financial damage from a compromised reputation if your office is targeted by a hacker?

The dangers of not staying on top of your IT are high, but as a dentist, it can seem impossible to keep up with everything. You have enough to do without worrying about IT and security. The IT experts at TechCentral, by Henry Schein One, help to take the IT stress out of dentistry. This allows you to focus on the expert dental care you give rather than IT.

A Simple Solution
TechCentral provides the IT services dental practices need, from computers and software to data backup solutions and remote monitoring and support. The newest offering is OmniCore, a “hardware as a service” offering, which means that rather than incur the cost to purchase and support networking hardware, customers pay a monthly fee for TechCentral to provide, maintain, and monitor all of the hardware.

OmniCore comes with everything essential to running your practice network, including a business-grade WatchGuard firewall and hybrid data backup—all within a low-profile rack that can be easily rolled into your dental practice. Because TechCentral retains ownership of the hardware, they take on the responsibility of maintaining and updating your software, and out-of-date components are automatically replaced.

Put your focus back on your patients and what you do best, and stop spending time and stress worrying about malware attacks and IT problems. Find out if TechCentral OmniCore is right for your practice. Schedule your free technology assessment today at (844) 588-6578, or visit www.HSTechCentral.com/StayOnTop.

Marc Laliberte joined the WatchGuard team in 2012. With speaking appearances at industry events and regular contributions to various security publications, Marc is a thought leader who provides insightful IT security guidance.

Marc Laliberte
Sr. Security Analyst, WatchGuard Technologies

You’re a dentist, not an IT professional. Buying and supporting each component of your dental office network can be overwhelming. TechCentral by Henry Schein One has OmniCore™, an all-in-one dental office network that includes all your essential network IT hardware, services and support for one low monthly cost. It’s like having an entire IT team right within the box. Stop worrying about your office network. Find out if OmniCore is right for your practice with a FREE technology assessment.

Visit www.HSTechCentral.com/YourTeam
You already depend on Dentrix to make your practice more profitable and productive. Now, you can turn Dentrix into an even more powerful solution by adding trusted, fully integrated third-party applications and capabilities to your digital dental office. The Dentrix Connected logo means the product has been carefully developed, tested and certified to work with your Dentrix platform. To see the full list of Dentrix Connected applications visit www.Dentrix.com/Connected today.
Panda Perio
www.pandaperio.com
Periodontal Practice Solution
The complete clinical digital record for periodontal practices. Charting, comparison reporting, treatment planning, automated chart notes, and much more. Save hours of admin time and unify your front and back office.

Lighthouse
www.lh360.com
Patient Communication Solution
Lighthouse 360 is a comprehensive automated patient communications system designed exclusively for dentists. It uses email, two-way text messaging, automated phone calls, postcards and letters to reach your patients.

Imagn
www.imagnsolutions.com
Imagn sleep software
We’ve spent years researching the best method of implementing sleep in dental practices. Now you can take advantage of our complete sleep solution to enrich the lives of your patients and add new revenue streams to your practice.

Patient Activator
www.patientactivator.com
Patient Communication Solution
Patient Activator, part of Los Angeles-based 1-800-DENTIST®, is the leading social media optimization and patient communications service dedicated to the dental profession.

ScanWriter
Want to know how profitable your practice can be? Use ScanWriter® Dentrix Edition to seamlessly integrate your Dentrix® data into QuickBooks (and other accounting software) and to improve your practice. You can automate your accounting process easily now for real-time monitoring of financial health and key performance indicators.

EasyRiter
www.easyriter.com
EasyRiter
EasyRiter® uses an anatomically driven menu system for clear, concise documentation of important, often referable, findings in their cone beam 3-D scans. Many common but unfamiliar radiographic findings are described in “pop-ups” which include a lesion description, a comparable image, and a citation of the importance of the finding.
Planmeca
www.planmeca.com

Planmeca Romexis® is an advanced, easy-to-use software suite providing a rich set of tools to meet the imaging requirements set by any dental facility – from a small clinic to a large hospital. It supports the most versatile range of 2D and 3D imaging modalities.

Podium
www.podium.com

Podium
Stop the guesswork and know what your patients are saying. With Podium, you can impact what’s said, where things are said, and how things are said. Podium helps over 3000+ organizations take full control of their online reputation. Podium can help you too.

Practice Mojo
www.practicemojo.com

Patient Communication Solution
PracticeMojo creates proven campaigns that help dental practices recruit, retain and reactivate patients automatically, using email, text messages, automated phone calls and mailed postcards.

RecordLinc
www.recordlinc.com

Patient Communication Solution
RecordLinc is the largest professional network of dental professionals in the world. Securely and easily send electronic referrals, patient transfers, and track treatment plans between dental practices in a HIPAA-compliant portal.

Reputation
www.reputation.com

Patient Communication Solution
Reputation.com’s platform enables dentists to see all their online reviews in one space and use the platform’s analytical tools to understand the broad themes that emerge from patient feedback.

Simplifeye
www.simplifeye.co

Simplifeye
The #1 mobile experience for dental providers, Simplifeye connects you, your patients, and your business in amazing ways via state-of-the-art consumer tech. Say goodbye to inefficiency and hello to a whole new way of running your practice.

Solutionreach
www.solutionreach.com

Patient Communication Solution
Smile Reminder provides patient engagement and communication solutions for healthcare practices. Utilizing the latest text, email, voice, video, web, and social media tools to communicate with customers.

TeleVox
www.televox.com

Patient Communication Solution
TeleVox Software is a high-tech engagement communications company, providing automated voice, email, text and web solutions that activate positive patient behaviors through the delivery of a human touch.

Transparent Aluminum
www.transparentaluminumllc.com

Dental Practice Solution
Transparent Aluminum is a company focused on creating custom workable solutions for practices to get the most out of their Dentrix database.
Updox Central for Dentrix
Updox is the industry-leading healthcare connectivity solution, offering dentists and practices a cohesive suite of services so practices can focus more on patient care and less on managing multiple platforms. With Updox, practices can lower costs, increase revenue, improve workflow, maximize staff time and increase efficiencies.

Yapi
Dental Practice Solution
Started as the first fully integrated intra-office communication software, YAPI has grown into a comprehensive suite of innovative automation solutions designed around unique needs of dental practices.

The product(s) and/or service(s) described herein are provided by a third party and the content and descriptions were created by such third party. Henry Schein One or its affiliates make no independent assessment of the content and descriptions provided by such third party. Henry Schein One is not responsible for, and expressly disclaims all liability for damages of any kind arising out of such third party products or services.

Get Dentrix News, Tips and Information
Sent Right to Your Inbox.
The Dentrix eNewsletter will help you stay up to date on the latest Dentrix product information, education opportunities, industry news, tips and tricks, promotional offers and more! Once a month you’ll receive an eNewsletter featuring the following content:

- Product Information
- Training & Support
- The Dental Business
- Partner Products
- Tips & Tricks

Sign Up Today at Dentrix.com/eNewsletter and don’t miss out on the most up-to-date Dentrix information!
Expand your care

...and your profits.
Let Dentrix G7 expand how you get work done, serve your patients and grow your profitability.

**For Clinical Staff:** Clinical workflow automation to keep you productive

**For Office Staff:** Office workflow improvements to reduce staff workloads

**For the Whole Office:** Integrated services to help your patients and your team

Upgrade to Dentrix G7 today.
Learn more at: Dentrix.com/G7/DTXmag

Expand Ability.
TIME TO START LISTENING

DATA CAN TELL YOU WHAT'S RIGHT AND WRONG IN YOUR PRACTICE

IMPROVE YOUR PROFITABILITY
Meet with a Dentrix Profitability Coach for a free 30-minute assessment. See what your data says about your practice’s strengths and weaknesses, and key areas to improve to immediately boost profits. Act now.

SCHEDULE YOUR FREE PRACTICE ASSESSMENT NOW AT DENTRIX.COM/DENTRIXMAGCOACH